UNIVERSAL DESIGN & ACCESSIBILITY IN POWERPOINT WORKSHOP
ONE HOUR INSTRUCTION + 30 MINUTE WORKSHOP

Office of Online Learning
Nashville State Community College
ww2.nscc.edu/onlinelearning/
This hour-long session will share and demonstrate best practices for creating accessible content as part of the TBR Accessibility Initiative on the NSCC campus. It will provide context for accessibility initiatives by briefly examining the evolution of accessibility in higher education, and will provide practical guidance and instruction for creating accessible content in Microsoft PowerPoint for on-ground, hybrid, and online courses.

Bring a course PowerPoint presentation or presentation content and stay for a half-hour hands-on workshop after the session where you can implement the accessibility skills you’ve learned.
# Table of Contents

Accessibility Introduction ........................................................................................................... 4
  Legislation ............................................................................................................................... 4

Accessibility at NSCC .............................................................................................................. 6
  What is Accessibility? ............................................................................................................. 6
  What is Accommodation? ........................................................................................................ 6
  What is the Difference? ........................................................................................................... 6
  What does this mean for me? ................................................................................................. 6

Accessibility Criteria ................................................................................................................ 7

Make sure content is clearly written and easy to read by choosing a pre-made template ......... 9
  Choosing a Theme ................................................................................................................ 9
  Theme Selection ................................................................................................................... 10
  Ensuring Sufficient Contrast ............................................................................................. 11
    Verifying Contrast Ratio .................................................................................................... 11
    Reverse Verification ......................................................................................................... 16

Provide appropriate document structure .............................................................................. 18
  Lists .................................................................................................................................. 18
  Slide Titles ......................................................................................................................... 18

Do not rely on color alone to convey meaning ..................................................................... 20

Ensure links make sense out of context ............................................................................. 25

Create accessible data tables ............................................................................................. 26

Other Resources: .................................................................................................................. 29
Accessibility Introduction

It is estimated that up to 4% of the population relies on some sort of Assistive Technology to access electronic documents and Web pages. Assistive Technology includes Screen Reading software, Refreshable Braille displays, and Screen Magnifiers. In the United States alone that equals 12.5 million people. If electronic documents are not created with accessibility issues in mind, they become very difficult if not impossible to read or navigate for this large number of people.¹

Accessibility to electronic documents is a right that is protected by both Federal and State law. Creating accessible electronic documents is important to ensure access to persons with disabilities and the company or agency is protected against legal action. Additionally, it is just good practice, when a very large segment of the population can equally participate and take advantage of the products or services that the company or agency provides.²

While course content should be designed with accessibility principles in mind, it is best for the focus to be on universal design: courses and course content should be usable by people with the widest possible range of abilities, operating within the widest possible range of situations. This is about making things accessible to all people (whether they have a disability or not).

Universal design in instruction addresses the need to create flexible goals, methods, materials, and assessments that accommodate learner differences. As we incorporate universally designed instructional practices, we help all students succeed while transparently providing the required accommodation for students with disabilities.³

Legislation

The Americans with Disabilities Act of 1990:
The ADA is a civil rights legislation that prohibits discrimination and ensures equal opportunity for persons with disabilities in employment, state and local government services, public accommodations, commercial facilities, and transportation. There are some provisions of the ADA that directly affect higher education. Title II applies to public universities and Title III applies to private universities⁴. The ADA clearly states that communications with persons with disabilities must be “as effective as communications with others.” The Office of Civil Rights has defined this effectiveness to include three components:

- Timeliness of delivery
- Accuracy of the translation
- Provision in a manner and medium appropriate to the significance of the message and the abilities of the individual with the disability

Section 504 of the Rehabilitation Act of 1973:
This legislation is applicable to all universities that receive federal funding. It states: “No otherwise qualified individual with a disability in the United States . . . shall, solely by reason of
her or his disability, be excluded from participation in, be denied the benefits of, or be subjected to discrimination under any program or activity receiving Federal financial assistance.”

Section 508:
In 1998, Section 508 was added to the Rehabilitation Act to require Federal agencies to make their electronic and information technology (EIT) accessible to people with disabilities and requires that Federal agencies' electronic and information technology is accessible to people with disabilities. While Section 508 does not directly apply to NSCC, it provides technical standards for accessibility."
Accessibility at NSCC

What is Accessibility?
“Accessible” means that individuals with disabilities are able to independently acquire the same information, engage in the same interactions, and enjoy the same services within the same time frame as individuals without disabilities, with substantially equivalent ease of use. A few examples of accessibility are accessible web pages, accessible instructional materials, accessible apps and an accessible eReader.

What is Accommodation?
“Accommodations” are reasonable academic adjustments or auxiliary aids that provide equal access to programs and services on an individual basis. A few examples of reasonable academic adjustments or auxiliary aids are extended time on tests, taking an exam in a minimal distraction area, recording a lecture, and having a note-taker.

What is the Difference?
Accessibility is achieved through the use of identified standards to design environments to be used by everyone, including persons with disabilities, and oversight is often provided by an accessibility manager and/or ADA coordinator.

Accommodations are requested by a person with a disability and determined to be reasonable on an individual basis by an appointed representative, often, in a disability services office. Accommodations may be needed beyond an accessible environment for equal access to programs and services because of the individual nature of the disability not due to an environment’s inaccessible design.

It might be helpful to remember: “Accessibility is for everyone; accommodation is for an individual.”

What does this mean for me?
In accordance with the Americans with Disabilities Act, Nashville State Community College makes every effort to provide students with disabilities access to online learning programs offered by the College. Since the Internet often serves as a key to accessing these programs, it is vital that the Web course content be accessible for all users.

Thus, this law mandates that all instructional materials be accessible. The TBR Higher Education Accessibility Task Force has specified that “instructional materials” are items that are created, purchased, or identified to serve in instruction and communication of information in the curricular settings at public higher education institutions in Tennessee. These items may include, but are not limited to, texts in bound, unbound, kit or package form, library media (print, non-print, and electronic resource), instructional software content, web/online content and learning objects, E-books, CD-ROM, DVDs, videos, slides, films and filmstrips, learning laboratories, recordings, manipulatives, consumables and ITV content.
Accessibility Criteria
Tennessee House Bill 1857 (Senate Bill 1692) established the need for minimum accessibility criteria for informational materials and related technology used by institutions of higher education. To adhere to the minimum Web Content Accessibility Guideline 2.0 A & AA recommendations provided by the Tennessee Board of Regents to the Tennessee Higher Education Commission, the following criteria must be met:

Make sure content is clearly written and easy to read by choosing a pre-made template
There are many ways to make your content easier to understand. Write clearly, use clear fonts, and choose templates with minimal distractive elements like pattern and texture.

Provide appropriate document structure
Headings, lists, and other structural elements provide meaning and structure to web pages. They can also facilitate keyboard navigation within the page.

Ensure links make sense out of context
Every link should make sense if the link text is read by itself. Screen reader users may choose to read only the links on a web page. Certain phrases like “click here” and “more” must be avoided.

Provide appropriate alternative text
Alternative text provides access to non-text content (such as images) in web pages. It is especially helpful for people who are blind and rely on a screen reader to have the content of a website read to them.

Do not rely on color alone to convey meaning
The use of color can enhance comprehension, but do not use color alone to convey information. That information may not be available to a person who is colorblind and will be unavailable to screen reader users.

Create accessible data tables
Tables should be used to organize data, not layout, and should use either the “scope” or “header and id” attributes for easier navigation with assistive technology.
Tutorials

As we learn how to meet each one of these accessibility guidelines, there are two principles to keep in mind:

- The skills that we learn in Microsoft PowerPoint in this workshop are transferable across authoring platforms. This means that these functions operate identically or very similarly in other Microsoft Office programs (Word, Excel), Adobe Acrobat, and D2L’s built-in HTML editor.
- Adhering to accessibility guidelines as part of a Universal Design approach to course content benefits all students—those with documented disabilities, those with undocumented disabilities, as well as those with no disabilities at all.
Make sure content is clearly written and easy to read by choosing a pre-made template

When creating accessible content, the first step is to plan the layout and content of your presentation before you begin. The more time you invest in planning, the less time you’ll have to spend fixing the document later. When planning your document, you might want to consider: how will the document look? What is the simplest and most logical way to convey this information?

Choosing a Theme

The design decision that makes the most impact in terms of accessibility is your choice to use a pre-made theme from the Design tab.

To choose a pre-made theme, navigate to the Design tab to view the available “Themes”:

Click the expansion arrow to browse all available “Themes”:

Clicking the expansion arrow will extend the Themes panel to expose all available “Themes”:
Selecting an available theme instead of creating your own template using the Text Box option is of the utmost importance when designing for accessibility. Screen readers navigate each slide using the predetermined structure of the available themes. For example, the text box that prompts users to “Click to add a title” is predesignated as containing the title of the slide. This means that this text box, regardless of its position on the slide, will be read to the user first. For this reason, it is important not only that PowerPoint presentations are built using only the pre-made themes, but that extra textboxes are not added to the slides.

**Theme Selection**

While there are many options for available themes, when designing for accessibility, it is important to use a theme with minimal distractive elements. This means choosing a theme without patterns or textures that may be distracting for some users. The following themes are most appropriate:

<table>
<thead>
<tr>
<th>Slide Sample</th>
<th>Slide Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Office View" /></td>
<td>Office View</td>
</tr>
<tr>
<td><img src="image" alt="Retrospect" /></td>
<td>Retrospect</td>
</tr>
<tr>
<td><img src="image" alt="Banded" /></td>
<td>Banded</td>
</tr>
<tr>
<td><img src="image" alt="Crop" /></td>
<td>Crop</td>
</tr>
<tr>
<td><img src="image" alt="Basics" /></td>
<td>Basics</td>
</tr>
<tr>
<td><img src="image" alt="Dividend" /></td>
<td>Dividend</td>
</tr>
<tr>
<td><img src="image" alt="Frame" /></td>
<td>Frame</td>
</tr>
<tr>
<td><img src="image" alt="Headlines" /></td>
<td>Headlines</td>
</tr>
<tr>
<td><img src="image" alt="Metropolitan" /></td>
<td>Metropolitan</td>
</tr>
</tbody>
</table>
Ensuring Sufficient Contrast
To ensure maximum readability by the largest audience, your presentation must use sufficiently contrasting foreground and background colors. Text should have a minimum ratio of at least 4.5:1. While a white background with black text (or vice versa) is always compliant, other color combinations may not provide a sufficient contrast ratio to adhere to Web Content Accessibility Guidelines (WCAG) 2.0 AA & AAA recommendations provided by the Tennessee Board of Regents.

This means that once you have chosen your desired theme, you must then choose a variant with sufficient contrast. Variations on a theme can be found in the Variants panel of the Design tab:

If you opt to select a color combination other than black/white, you must ensure that your color combination offers a high enough contrast.

Verifying Contrast Ratio
The process for determining contrast ratios is a lengthy one. The first thing you must do is determine the RGB color codes for both the foreground and the background colors.

To do this, once you have selected your theme and variant, click the expansion arrow in the Variants panel:

Select “Colors” to open the Custom Panel:
This will open the Custom panel. Select the “Customize colors…” option:

This will prompt the “Create New Theme Colors” dialog box:

This “Create New Theme Colors” dialog box is where you will determine the color codes for your foreground and background colors. First locate the foreground, and then click its action.
arrow. Note that the foreground color for that slide is not necessarily one of the “Text/Background” options.

In this example, the foreground color that needs to be verified is actually in the “Accent 2” slot:

![Accent Colors](attachment:image.png)

After clicking the action arrow, select the “More Colors…” option:

![More Colors](attachment:image.png)

This will open the “Colors” dialog box. Select the “Custom” tab and then locate the RGB color code for your foreground color:

![Custom Colors](attachment:image.png)
Take note of the color code. The color code for this foreground color is:
Red: 144
Green: 49
Blue: 99

Then, click “OK”:

Clicking “OK” will return you to the “Create New Theme Colors” dialog box. Now, find the color code for your background color in the same manner by locating the color and clicking its action arrow. Select “More Colors…” Select the “Custom” tab, and then take note of the color code. In this example, the color code for my background color is as follows:
Red: 255
Green: 255
Blue: 255

The next step in determining the color contrast ratio between our two colors is to take the RGB color codes and translate them to HEX color codes. To do this, visit RBGtoHEX.net and input the color code for your foreground color, and click “Convert to HEX”:
After clicking “Convert to Hex,” both the color swatch and the HEX code will appear. Note that while RGB color codes are comprised of a three three-digit numbers, HEX color codes are comprised of a single six-character code that may include both numbers and letters.

In this example, the HEX color code for my foreground color is 903163. Take note of that code. Next, you will determine the HEX color code for the background color by inputting the RGB code into the translator. In this example, my background HEX color code is FFFFFF.

Now that I have determined the HEX color codes for both my foreground and background colors (903163 and FFFFFF), visit Snook Colour Contrast Check. Input the HEX code for both the foreground and background colors in the appropriate boxes. Note that once the code has been input, the color swatch will adjust to reflect the color you have selected.
The final step toward deciphering whether this foreground/background color combination has enough contrast to be considered WCAG compliant is to analyze the Results Panel:

![Results Panel](image)

For a color combination to be WCAG AA compliant, the Contrast Ratio must be at least 4.5. To be WCAG AAA compliant, the Contrast Ratio must be at least 7. If the font size of the slide in question is at least 18 points, AA compliance is sufficient.

**Reverse Verification**

If your color combination does not offer sufficient contrast, you can use the Hue, Saturation, and Value slides to adjust the colors until there is a sufficient contrast ratio:

![Hue, Saturation, and Value Slides](image)
Once the results panel indicates that there is a sufficient contrast ratio, take note of the foreground and background HEX codes.

Visit [RGBtoHEX.net/HEXtoRGB](http://RGBtoHEX.net/HEXtoRGB). Input the HEX code and click “Convert to RGB”:

You entered Hex code: #903163 which converts to the following in RGB: R: 144 G: 49 B: 99

The RGB value above corresponds to the following color:

![RGB Color](image)

Take note of the RGB code, and place that in the corresponding color in PowerPoint, then click “OK”:
Provide appropriate document structure

Lists

Any content that is organized as a list should be created using the list controls that are provided. Document authoring tools usually have one or more controls for adding lists. Using the available tools to create lists helps assistive technologies understand how the content is organized. Also, when screen reader navigates a list, the screen reader informs the user that they’re on a list and informs them of how many items are in the list. Not using the list tool (for example, simply using hyphens “–” or asterisks “*”) can make content more difficult to navigate and understand using assistive technology.

To include accessible lists in your course content using Microsoft Word, select either the Bullets, Numbering, or Multilevel List options from the Paragraph portion of the Home tab:

Unordered lists (bullet points) should be used when there is no specific order intended for the list you are creating.

Ordered lists (numbers, letters) should be used when there is a defined sequence or order intended for the list.

Slide Titles

It is important for users accessing PowerPoint presentations via a screen reader that each individual slide has a unique title that is related to its content. This will allow users to more easily navigate between slides without having to filter through its entire content in order to locate important information. To ensure that each slide has a unique title, select the View tab, locate the “Presentation Views” panel, and select “Outline View”:
This will expand the left panel to show each slide along with its content:

1. **BRAIN Decision Making**

2. **Benefits**
   - What are the benefits of going ahead with this decision?

3. **Risks**
   - What are the risks associated with doing this procedure or making this decision?

4. **Alternatives**
   - What alternatives are available here? What alternatives are there that might not be available here but available somewhere else?

5. **Intuition**
   - What does your gut tell you?

6. **Nothing**
   - What comes next if we say “yes”? What happens if you say “no”?

The slide’s title appears in bold next to the slide icon. Here, you are able to view all of the slides for your presentation at once. If any two slides have similar titles, make sure you change them so that each slide has a unique title. Similarly, you want to make sure that the title reflects the content of the slide. A title like “Next” or “Important” does not indicate to the student what type of information they will encounter on that slide. This will make navigating the presentation difficult.
Do not rely on color alone to convey meaning

When color is used to enhance or enliven the visual display of a page, people who cannot access color will not necessarily suffer from reduced usability. They will still be able to access the materials on the site and to operate the site functions. However, when color is an integral part of the user interface, people who cannot access color may encounter difficulties. When color is used to convey information or to provide direction—as an indicator, to draw attention to interface elements or important text, and to provide status information—nonvisual users as well as some visual users will be affected. Color is an extremely effective method for creating emphasis and providing feedback—two essential aspects of a user interface. The solution is to provide redundant emphasis and feedback using other, accessible methods.

Use headers or formatting elements such as underlines, borders, or other symbols along with color to convey meaning. Printing a color document in black and white is the best test to see if you have lost any meaning. In the example below, the essential information (which assignments are required) is relayed using color only; the information is lost when printed in black and white. The simple addition of the asterisk symbol allows the document to maintain meaning when in black and white.

Universal Design: Avoiding use of color to convey essential information ensures that the information is accessible to those who can’t reliably discriminate between colors. This group includes people with blindness and color blindness, but it also includes people using monochrome monitors and hand-held computers with green screens. It also benefits people who are using voice web services.

Provide appropriate alternative text
Alternative text provides a textual alternative to non-text content in web pages. It is read by screen readers in place of images allowing the content and function of the image to be accessible to those with visual or certain cognitive disabilities. The key principle is that computers and screen readers cannot analyze an image and determine what the image presents. As content developers, text must be provided to the user which presents the content and function of the image.\textsuperscript{xi}

To insert a photo into your presentation, select a slide design that designates a space for a picture. In the Home tab, click “New Slide.” This will open the Theme dropdown menu:
Select a theme that leaves space for a photo or illustration:

To insert a photo, click the photo icon on the slide:

Locate the photo on your computer, then click “Insert.”
Once the photo has been inserted, right-click the photo and select “Format Picture…”:

This will open the “Format Picture” panel. Select the Size & Properties icon:

Click the ALT TEXT action arrow to display the “Title” and “Description” bars:
The text alternative for a simple image should be typed in the “Description” bar and limited to no more than 120 characters as a rule of thumb, while the alternative text for graphs, tables, and complex images (such as detailed maps and diagrams) should give a brief summary of the included information and follow with contextual description in the body text around or under the complex graphic. If the body of the document already contains a sufficiently detailed description, the alternative text can simply identify the image so that the reader knows when it is being referred to. There are no hard and fast rules for determining what alternative text should say (it depends on the image, its context, the intent of the author, etc.), one simple trick is to imagine describing the image to someone over the phone. The more important an image's content is, the more descriptive the alternative text should be. If images are purely decorative and contain no informative content, they do not require a description (in this case, type double quotation marks in the “Description” bar).

Unless the image has an identifiable title (The Starry Night, Mona Lisa), leave the “Title” bar blank.
Ensure links make sense out of context
Meaningful link text should not be overly general and should clearly describe the content to be found or action performed at the destination. Specifically, this should occur directly in the link text making the link's purpose understandable when taken out of context. For example, do not use "click here." Not only is this phrase device-dependent (it implies a pointing device), but also it conveys nothing about what is to be found if the link is followed. Instead of "click here," link text should indicate the nature of the link target, as in "more information about sea lions" or "text-only version of this page." Many users of screen readers will access links on a page via a list of links and thus must be able to discern the purpose of a link when taken out of the context of the surrounding content. xii

To add a hyperlink to a slide, place your cursor in the text box where you want the hyperlink. Then, on the Insert tab, in the Links group, select Hyperlink:

This will open the Insert Hyperlink dialog box:

In the “Text to display” bar, type in the name or phrase that will briefly describe the link destination. In the “Address” bar, type the URL. Click “OK.”
Create accessible data tables

First you need to consider if you can use a list instead of a table in your presentation. Often a list will convey your data in an easier to navigate group than a table. Tables are useful for identifying relationships between data when those relationships are best conveyed with rows and columns. To make data tables accessible to assistive technology users, you will need to clearly identify column and row headers. After you determine your data is best presented in a table, keep the table simple. Complex tables can be difficult for assistive technology users to navigate and understand unless they include markup that identifies the relationships between headers and data cells. An accessible complex table needs to be authored with an HTML editor. Do not split cells, leave cells blank, or use a table for layout.

Tables should not be used for document layout. Word can do this with styles, and formatting—including organizing content into columns.

On the Insert tab, click the “Table” icon:

This will prompt the “Insert Table” dialog box:

Move your cursor across the provided grid to select your desired table size. As you slide your cursor, you will see a table appear and adjust size in the body of your document. Once you have selected the desired table size, click “Insert Table…”:
Once you have inserted your table, you can adjust settings in the Design tab:

Check the “Header Row” option on the left side of the tab. Also, remember to keep color contrast in mind as you select the colors for your table.

Once your table has been populated with data, right-click on the shape and click “Format Shape…”:
From here, alternative text for the table must be included the same way that alternative text for images was included. See Provide appropriate alternative text.
Other Resources:
The National Center for Disability and Access to Education has created one-page accessibility resources to assist in creating accessible content. For help creating accessible material to enhance your course, reference the following documents:

NCDAE Microsoft Word 2013 Accessibility Cheatsheet
NCDAE Microsoft Powerpoint 2013 Accessibility Cheatsheet
NCDAE Microsoft Excel 2010/2013 Accessibility Cheatsheet
NCDAE Adobe Acrobat XI Accessibility Cheatsheet
NCDAE YouTube Accessibility Cheatsheet

iii http://teachingcommons.cdl.edu/access/materials/fwis.shtml
iv https://ux.mit.edu/accessibility/laws
v https://ux.mit.edu/accessibility/laws
vi http://www.nscc.edu/resources/web-accessibility-statement/
vii https://www.tbr.edu/sites/tbr.edu/files/media/2015/08/Accessibility%20Task%20Force%20Recs-Final.pdf
viii http://universalusability.com/access_by_design/color/alone.html
ix https://itaccessibility.illinois.edu/word-documents/color
x http://www.accessibletech.org/access_articles/webinfo/accessibleWebBenefit.php
xi http://webaim.org/techniques/alttext/